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Microsoft Word 2010: 
Formatting Your Research Paper using MLA Style 

 

Introduction  
This reference guide provides instructions for formatting your research paper with Microsoft Word 2010. This 
guide is written for users who are familiar with the basic features of Word 2010. When you write a research paper, 
it is important to follow a particular formatting style throughout your paper. A consistent style enhances 
readability and helps to give your paper a professional appearance. The following information is based on the 
format set out in the MLA Handbook for Writers of Research Papers (7th edition) published by the Modern 
Language Association of America. This style is commonly used in areas of literature, arts, and the humanities.  
 

Note: The information that follows is intended as a general guide and does not address all aspects of MLA 
style formatting. For more detailed guidelines see the latest edition of the MLA Handbook for Writers of 
Research Papers, available at any library, or visit the Marygrove College Writing Center, room LA 028 in 
the Liberal Arts Building.  

 
Formatting pages  
Your paper should be double-spaced throughout, including the list of works cited. Margins should be one inch in 
all directions (top, bottom, left, right). Indent the first word of a paragraph one-half inch from the left margin. The 
proper font size is 12-point font; the acceptable font type is Times New Roman. All type should be set flush with 
the left margin, creating an uneven right margin (NOT justified).  
 

To set margins:  
1. Open a new document in Word 2010.  
2. Click the Page Layout tab.  
3. Click the Margins button in the Page Setup group.  
4. Select Normal.  

 

To set font:  
1. Click on the Home tab.  
2. In the Font group, click the down arrow to the right of the font menu (the default font type is Calibri).  
3. Select Times New Roman.  
4. Click the down arrow to the right of the font size menu (the default font size is 11).  
5. Select 12 as the font size.  

 

To set line spacing:  
1. In the Paragraph group (still on the Home tab), click on the Line Spacing button: 
2. Select 2.0 for double-spacing.  
3. Click on the Line Spacing button again and select Remove Space After Paragraph. (This will undo the 

default setting in Word 2010, which adds a small space after each paragraph.) 

 

Adding page numbers  
When you add page numbers to your paper, Word will automatically number each new page in your document. In 
MLA format, the page number appears in the upper right corner of each page, one inch from the right edge and 
one-half inch from the top of the paper. Number all pages consecutively starting with the title page. Use Arabic 
numerals (1, 2, 3…) for page numbers; type your last name before the page number.  
 
To add page numbers:  

1. Click on the Insert tab.  
2. Click the Page Number button in the Header and Footer group.  
3. On the Page Number menu, select Top of Page.  
4. Select Plain Number 3 from the choices that appear on the left side of your screen. This will position the 

page number on the upper right corner of each page.  
5. Type your last name followed by a space. This text will move to the left of the number.  
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6. Select (highlight) all the text in the header (name and page number) and set the font to Times New 
Roman and the font size to 12.  

7. Click on the red Close Header and Footer button located at the top right of the tool bar.  

 
Heading and Title  
A title page is not required in MLA format. Place your heading in the upper left corner of the first page of your 
research paper, one inch from the top of the page and flush with the left margin. Your heading should include the 
following information (on separate lines and double-spaced):  

 your name,  
 your instructor’s name,  
 the course name/number, and  
 the date.  

 
Double-space again and center the title of your paper. Do not italicize your title, put it in quotation marks, or type 
it in all capital letters. Double-space also between the lines of the title (if necessary) as well as between the title 
and the first line of the text.  
 

 
The top of the first page of a research paper 

 

Citing sources within the text  
MLA guidelines require that you cite quotations, summaries, paraphrases, and other material used from sources 
within parentheses typically placed at the end of the sentence in which the quoted or paraphrased material 
appears. The parenthetical method replaces the use of footnotes. These in-text parenthetical citations correspond 
to the full bibliographic entries found in a list of works cited at the end of your paper. Source material must be 
documented in the body of the paper by citing the author(s) of the source and page number(s) on which the 
borrowed information can be found. Notice that the period at the end of the sentence is placed after the 
parenthetical citation.  
 
Examples:  
 

The authors argue that numerous members of the scientific community found Einstein’s theory 
flawed (Smith and Jones 76).  

 
If the last names of the authors appear in the sentence, then only the page number is required:  
 

In their controversial article, Williams and Martinez claim the results of the university study were 
inconclusive due to the “unscientific method of data collection” (121).  

 
For more than 3 authors, use the first author’s last name, followed by the abbreviation et al.:  
 

(Hunter et al. 97).  
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If no author is available, use a short form of the title (the shortest form that will allow you to recognize  
the work properly). For instance, if you were working with an anonymous article titled “Low-Income  
Parents and Public Schools,” you might use the following:  
 

(“Low-Income Parents” 251)  
 

If citing a source within another source, use the abbreviation qtd. in. For instance, if you wish to cite  
Bill Clinton as he appears in an article by Jonathan Alter, you would use:  
 

(Clinton, qtd. in Alter 37)  
 

 If the source of the quotation is named in the main part of the sentence (e.g., “Former President 
Clinton stated . . .”) do not include it again in the parenthetical citation.  

 
For a quotation from an electronic source such as an online article or web page, give a paragraph or section 
number if no page number is available. You may use the abbreviation par. (or pars. for multiple paragraphs). 
 

Angelou’s second book covers her youthful adventures as “a mother, a Creole cook, a madam, a tap 

dancer, a prostitute and a chauffeurette” (“Maya Angelou,” par. 4). 

Long quotations  

When you include long quotations (more than four typed lines), you must use a colon after the formal 
introduction, indent the quotation one inch from the left margin, omit the quotation marks, and place the 
parenthetical citation after the closing punctuation mark. Like everything else in an MLA-style paper, the long 
quotation is double-spaced.  
 

To format a long quotation:  
1. Begin the quotation on a new line.  
2. Type the quotation, and then select (highlight) the text.  
3. If necessary, click on the Home tab.  
4. Click the dialog box launcher (small button in the lower right corner) in the Paragraph group.  
5. In the Paragraph dialog box, under the Indents and Spacing tab, change the left indentation to 1”.  
6. Click OK  

 

Works Cited page 

Your list of Works Cited begins on a separate page, after the last page of your paper.  
 
To create a new page:  

1. Place the cursor after the last word in your paper. 
2. Click on the Insert tab.  
3. Click the Page break button in the Pages group.  

 
Type the heading Works Cited centered on the first line of the new page. The references (with hanging indent – 
see below) begin on the line following the Works Cited heading. Double-space within and between reference 
sources. Entries are organized by last names of first authors.  
 
To create a hanging indent:  

1. Select (highlight) all references on the Works Cited page.  
2. If necessary, click on the Home tab.  
3. Click the dialog box launcher (small button in the lower right corner) in the Paragraph group.  
4. In the Paragraph Dialog Box, under the Indents and Spacing tab, go to the menu for Special indentation, 

and select Hanging.  
5. Click OK   



Last updated 1/9/2012  5 

Bibliographic citations for various reference sources  
 
The numbers immediately after each type of reference source ( 5.5.2 , for example) refer to the corresponding 

chapter and section numbers in 7
th

 edition of MLA Handbook for Writers of Research Papers. 
 
I. Printed book (See p. 9  for ebook citation.) 

 The basic elements of a book citation are: 
o Author 
o Book title 
o City where the book was published 
o Name of the book’s publisher 
o Year the book was published 
o Medium (i.e., the form in which it’s delivered: either Print or Web. 

 The authors' names should be given as they are on the title page of the text, in the order they appear 
(which will NOT always be alphabetical).  

 Abbreviated forms of publishers’ names are acceptable, for example:  
o Omit articles (A, An, The), business abbreviations (Co., Corp., Inc., Ltd.), and descriptive words 

(Books, House, Press, Publishers).  
o When citing a university press, always add the abbreviation U for University and P for Press (Yale 

UP; U of Michigan P).  
 

Book with one author 5.5.2 

 

 

Biesen, Sheri. Blackout: World War II and the Origins of Film Noir. Baltimore: Johns Hopkins UP, 2005. 

Print.  

 

 

 
Book with one editor 5.5.3 

 If the name of an editor appears on the title pages, then a comma should come after his/her last 
name in the entry and the abbreviation ed. should follow the comma (eds. for more than one editor.  

 

Diawara, Manthia, ed. Black American Cinema. New York: Routledge, 1993. Print.  

 
Book with two or three authors/editors 5.5.4 

 In each entry, the first author's name should be reversed, followed by a comma, and then each 
additional author's name in its normal order. 

 

Idliby, Ranya, Suzanne Oliver, and Priscilla Warner. The Faith Club: A Muslim, a Christian, a Jew—Three 

Women Search for Understanding. New York: Free Press, 2006. Print.  

 
Book with four or more authors/editors 5.5.4 

 List only the name of the first author/editor, followed by a comma and et al. 
 

Broughton, Simon, et al., eds. The Rough Guide to World Music. London: Rough Guides, 2006. Print.  

 
  

City of 

Publication 

Year of 

Publication Author 

Medium 

Publisher Title (in Italics) 
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Book with a corporate (group) author 5.5.5 
 

Booth Western Art Museum. The Black West: Buffalo Soldiers, Black Cowboys, & Untold Stories. 

Cartersville, GA: Booth Western Art Museum, 2009. Print.  

 
Two or more books by the same author 5.5.4 

 Give the author’s name in the first entry only; thereafter, in place of the name, type three hyphens, 
followed by a period and the title. 

 

Anderson, Elizabeth. Power and Possibility: Essays, Reviews, and Interviews. Ann Arbor: U of Michigan 

P, 2010. Print.  

---. The Venus Hottentot. St. Paul, MN: Graywolf, 2004. Print.  

 
Book published in a second or later edition 5.5.13 

 Identify the edition by number after the title of the work.  
 

Perry, John, and Michael Bratman, eds., Introduction to Philosophy. 3rd ed. New York: Oxford UP, 1999. 

Print. 

 
One selection from an anthology or an edited book 5.5.6 

 

 

 

Abdulahad, Tania. “Black Lesbian/Feminist Organizing: A Conversation.” Home Girls: A Black Feminist 

Anthology. Ed. Dara Smith. New Brunswick, NJ: Rutgers UP, 2010. 315-18. Print.  

 

 

 

 
Encyclopedia article 5.5.7  &  5.5.14 

 Note: Page numbers are not used when citing articles in works arranged alphabetically (like encyclopedias).  
 
 
 

 

 

Graziano, Jay. “Minstrelsy.” Encyclopedia of the Harlem Renaissance. Ed. Cary D. Wintz. Vol. 2. New York: 

Routledge, 2004. Print. 

 

 

 
 

 

  

City of 

publication 

The abbreviation 

“Ed.” followed by 

the name of the 

editor 

Title of the encyclopedia 

(in Italics) 
Author of 

the article  

Medium 

Page numbers of 

the selection 
Year  City of 

publication 

The abbreviation “Ed.” 

followed by the name of 

the editor 

Title of the selection 

(in quotes) 
Author of the selection 

(chapter, essay, etc.) 

Publisher 

Title of the article 

(in quotes) 

Title of the book 

(in Italics) 

Publisher Year 

Medium 

Volume #, if a 

multi-volume 

work 
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Medium 

Volume 

number 

Issue 

number 

(if it has 

one) Year of 

publication 

II.  Periodical article from a print source (including journals, magazines, newsletters, and newspapers)  

 The basic elements of a periodical citation are: 
o Author 
o Title of the article 
o Title of the periodical 
o Volume and issue number  
o Date of publication 
o Page number(s) 
o Medium (print) 

 

 Article from a journal (with volume and issue number) 5.4.2 

 

 

Anderson, Paul Allen. “Ralph Ellison on Lyricism and Swing.” American Literary History 17.2 (2005): 

280-306. Print.  

 

 

 

Article from a monthly or bimonthly periodical (includes month in publication date)  5.4.6 

Quirk, Matthew. “Bright Lights, Big Cities: Slums are Burgeoning Worldwide—and that’s a Good Thing.” 

The Atlantic Monthly Dec. 2010: 32-3. Print.  

 
Article from a weekly or biweekly periodical (includes month and day in publication date) 5.4.6 

Gross, Daniel. “Is America Losing at Globalization?” Newsweek 8 Sept. 2008: 66-7. Print.  

 
Article from a daily newspaper (includes month and day in publication date) 5.4.5 

 If the city is not included in the name of a locally produced newspaper, add the city in square brackets 
(not italicized) after the name. For example: Star-Ledger [Newark].  

 
Crumm, David. “Racial Sobriety and the Church: Detroit Priest Brings Awareness-Training Program to 

New Job at Catholic Charities in Washington.” The Washington Post 28 July 2010: B8. Print.  

Hammond, Norman. “Dig Reveals Foundations of Shakespeare’s Theatre.” The Times [London] 6 Aug. 

2010: 53. Print.  

 

  

Author(s) of the article  Title of the article (in quotation marks)  
Title of the journal 

(in Italics) 

Page 

numbers  
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Medium 

Issue number 

(if it has one) 

Database 

name  
Retrieval 

date  

Year of 

publication  

III. Periodical article from a database (ProQuest, JSTOR, MLA International Bibliography, etc.) 

 The basic citation elements of a periodical from a database are: 
 

o Author o Page number(s) 
o Title of the article o Database name 
o Title of the periodical o Medium (web) 
o Volume and issue number  o Retrieval date 
o Date of publication  

 

Please note: Many periodical databases now provide links or tools to generate bibliographic 

citations. These are often inaccurate and should not be used as a substitute for the instructions 

in this guide or the MLA Manual. 

 

Database article from a journal (with volume and issue number) 5.6.4 

 
 
 
 

Warf, Barney, and Morton Winsburg. “Geographies of Megachurches in the United States.” Journal of 

Cultural Geography 27.1 (2010): 33-51. Academic OneFile. Web. 15 May 2011.  

 

 

 

 

 

Database article from a monthly or bimonthly periodical (includes month in publication date) 5.4.6  &  5.6.4 

Quirk, Matthew. “Bright Lights, Big Cities: Slums are Burgeoning Worldwide—and that’s a Good Thing.” 

The Atlantic Monthly Dec. 2010: 32-3. General Reference Center Gold. Web. 17 November 2010.  

 

Database article from a weekly or biweekly periodical (includes month and day in publication date) 5.4.6  &  5.6.4 

Gross, Daniel. “Is America Losing at Globalization?” Newsweek 8 Sept. 2008: 66-7. Lexis-Nexis Academic. 

Web. 26 December 2008.  

 
Database article from a daily newspaper (includes month and day in publication date) 5.4.5  & 5.6.4 

 If the city is not included in the name of a locally produced newspaper, add the city in square brackets 
(not italicized) after the name. For example: Star-Ledger [Newark].  

 
Crumm, David. “Racial Sobriety and the Church: Detroit Priest Brings Awareness-Training Program to 

New Job at Catholic Charities in Washington.” The Washington Post 28 July 2010: B8. Lexis-

Nexis Academic. Web. 23 October 2008.  

Hammond, Norman. “Dig Reveals Foundations of Shakespeare’s Theatre.” The Times [London] 6 Aug. 

2010: 53. InfoTrac Custom Newspapers. Web. 2 March 2009.  

  

Page 

numbers  

Author(s) of the article  Title of the article (in quotation marks)  
Title of the journal 

(in Italics) 

Volume 

number 
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IV. Internet sources  

Electronic book (ebook) 5.6.2c  

 To create a citation for an ebook, follow the guidelines for a printed book (see p. 5) but add the name 
of the ebook provider after the year of publication, followed by the word Web for the medium 
(instead of Print) and the date you accessed the ebook. 

 
Thomas, Richard W. Life for Us is What We Make It: Building Black Community in Detroit, 1915-1954. 

Bloomington, IN: Indiana UP, 1992. NetLibrary. Web. 20 January 2011.  

Spencer, Herbert. Education: Intellectual, Moral, and Physical. New York: Appleton and Co., 1860. Google 

Books. Web. 21 May 2011. 

 
Article or web page from a larger web site 5.6.2 

 The basic elements of a citation for a web page or article from a web site are: 
o Author(s), if known 
o Title of article or web page 
o Name of web site 
o Website publisher or sponsor (group, organization, institution, etc.) 

 When no publisher name appears on the website, write N.p. for no publisher given. 
o Date of publication or of last update (if known) 

 When sites omit a date of publication, write n.d. for no date.  
o Medium (in this case, Web) 
o Date you accessed the web page 

 

 

 

Adler, David. “Two Turntables and a Saxophone: How Jazz Plays off Hip-Hop.” Slate Magazine. 

Washington Post-Newsweek Interactive Co., 22 Nov. 2005. Web. 6 April 2010.  

 

 

 

More Examples:  

Gates, Anita. “Shakespearean in a Down-Home Vernacular.” New York Times. New York Times, 29 May 

2009. Web. 3 June 2009.  

 “Music Therapy.” Cancer.org. American Cancer Society, 10 November 2008. Web. 14 September 2010.  

 “Samuel R. Delany.” Wikipedia, The Free Encyclopedia. Wikimedia Foundation, Inc., 20 November 2010. 

Web. 28 November 2010. 

 

 Also, MLA no longer requires a URL (web address) when citing a web resource. You should, 
however, include the URL if the citation information does not lead readers to easily find the source, 
or if your instructor requires it.  

 Note: After you type or paste a URL into your paper and press the [Enter] key (or the spacebar), 
Microsoft Word may automatically hyperlink the URL – that is, it becomes blue, underlined text that 
will link to the webpage with that URL when you click on it. To remove the hyperlink, right-click on 
the URL and select “Remove Hyperlink.” 

 

Author Article title (in quotation marks) 

Website name 

(in italics) 

Website publisher Date of 

publication 
Date of 

access 
Medium 
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Medium Distributor Release year 

Date of 

issue Medium 
Manufacturer 

Performer 

Multipage web site 5.6.2 

Eaves, Morris, Robert Essick, and Joseph Viscomi, eds. The William Blake Archive. Library of Congress, 

26 March 2009. Web. 15 May 2011.  

Yorubaland. Center for Exposition of Yoruba Arts and Culture. n.d. Web. 9 September 2010. 

 

Article from an online-only periodical (ejournal) 5.6.3 

 For articles that appear in an online-only journal or magazine, use the abbreviation n. pag. for no 
pagination.  

 

Rwomire, Apollo. “The Role of Social Work in National Development.” Social Work & Society. 9.1 (2011): 

n. pag. Web. 10 April 2011.  

 
 
V. Other sources 

A film or video recording 5.7.3 

 The basic elements of a video recording (movie, documentary, etc.) are: 
o Title 
o Director(s) 
o Medium (DVD, VHS, etc.) 
o Distributor 
o Release year 

 Names of other relevant contributors such as screenwriter, producer, or performers may also be 
included, but are not required.  

 
 

 

 

When the Levees Broke: A Requiem in Four Acts. Dir. Spike Lee. DVD. HBO Documentary Films. 2006. 

 

A sound recording (physical format only; see p. 11 for digital format) 5.7.2  

 The person or group cited first in the entry (composer, conductor, performer) depends on the desired 
emphasis; for example, is the source included in your research because of who wrote the piece, who 
conducted the performance, etc.? 

 After the title of the recording, list any other relevant artists and identify them by role: Comp. 
(composer), Cond. (conductor), Perf. (performer). 

 Include the name of the manufacturer, the date of issue, and the medium (Audiocassette, CD, etc.) 

 If you are citing a specific song, place its title in quotation marks. 
 

 

 

Ndegeocello, Meshell. “You’ve Really Got a Hold on Me.” Standing in the Shadow of Motown: Original 

Motion Picture Soundtrack. Hip-O Records, 2002. CD. 

 

 

Title (in Italics) 
Abbrev. “Dir.” and 

director’s name 

Album title 

(in Italics) 

Song title  

(in quotation marks) 
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Performer 

Date of 

issue 

Manufacturer 

Medium 

 

 

 

Tchaikovsky, Peter. Complete Suites. Perf. Detroit Symphony Orchestra. Cond. Neeme Jarvi. Musical 

Heritage Society, 2003. CD. 

 

 

 

A work of visual art 5.7.6 

 To cite a work of art such as a painting, sculpture, or photograph, include: 
o Artist’s name, if known 
o Title of the work 
o Date of composition or creation, if known 

 Use N.d. for no date 
 Use the abbreviation c. (meaning ‘circa’ or ‘around’) for an approximate date 

o Medium of composition 
o Institution that houses the work  
o City where the institution is located 

 
Hunt, Richard. Column of the Free Spirit. 2000. Bronze. Frederik Meijer Gardens and Sculpture Park, 

Grand Rapids, MI.  

Tanner, Henry Ossawa. Flight into Egypt. 1899. Oil on canvas. Detroit Institute of Arts, Detroit. 

 

 For a photographic reproduction in a book or periodical, list the institution and the city (if known) 
plus the information for the source in which the image appears, including page number.  

 
Durer, Albrecht. The Four Horsemen of the Apocalypse. c. 1496. Woodcut. Museum of Fine Arts, Boston. 

The Humanistic Tradition. By Gloria Fiero. Vol. 1. Boston: McGraw-Hill, 2006. 474. Print. 

Henderson, John. Flowers. 2010. Framed color photograph. Golden Gallery, Chicago. ARTFORUM. 

“Reviews: Chicago.” By Michelle Grabner. April 2011: 221. Print. 

 
Digital audio file (downloaded) 5.7.18 

Blige, Mary J., perf. “Be Without You.” The Breakthrough. Geffen Records, 2005. MP3 file. 

 
Interview (that you conducted) 5.7.7 

 Include the name of the person interviewed (not your name), the kind of interview (Personal, 
Telephone), and the date. 

 

Fike, David J. Personal interview. 11 May 2011. 

Worthy, Kym L. Telephone interview. 23 Oct. 2010. 

 

Album title 

(in Italics) Composer Conductor 


